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Glossary



Menu Bar
Nature Collector Freshwater Fish contains a standard Windows Menu Bar, which is situated at
the top of the screen.      You can access the Menu Bar by either pressing the ALT key, or by 
moving the mouse cursor to the upper left corner of NC-FF window.    You can hide it by 
pressing ESC, ALT, or moving the mouse cursor below the Menu Bar itself.    The Menu Bar 
consists of the following menus: 
Files menu
Edit menu
Options menu
Window Screen 
Help menu



Museum Control buttons
Museum Control buttons are situated at the bottom of the lobby, travel, museum, and 
location screens. These buttons allow you to switch between the main parts of the game. 
Click on the descriptions of these buttons to see how each functions.

Lobby Button
Museum Button 
Travel button 
Guide Book button 
Help Button



Lobby screen
The Lobby screen is the place where you can look at the table of scores, view the 
instructional video, and login a new player into the game.    At any time in the game you can 
return to the Lobby screen by pressing the Lobby button or by accessing the Menu bar, 
clicking on Window, and then clicking on Lobby.

How to...
Log in the game 
Enter a new name    
Change a name    
Delete a name    

Interface components
Video Control Buttons
Video Progress Bar
Video Playback Area
Museum Control buttons 



Travel screen
In the travel screen you will decide where in the world you want to go fishing. You can go to 
the travel screen by just clicking on the Travel    button which is situated at the bottom of 
the screen, among other Museum Control Buttons.    The Travel screen can also be accessed 
through the Menu Bar, by clicking on Window and then clicking on Travel.

How to ...
Choose fishing location 
Go Fishing 

Interface components
Container window 
Map window
Current Location Info window
Museum Control buttons



Location screen
In the location screen, you can catch the fish by using the fishing equipment that is 
displayed in the Container Window at the top of the screen. You can get here by clicking the 
Go Fish button on the Travel Screen. You can go back to the Museum Screen by pressing the
ESC key.

How to...
Catch a fish 

Interface components
Container window
Fishing Location Screen
Museum Control buttons 



Museum screen
The Museum Screen provides you with the tools and data to setup, view and maintain 
museum displays.    You can access the Museum Screen either by pressing the Museum 
button, which is one of the Museum Control buttons, or by accessing the Window menu in 
the Menu Bar, and clicking on Museum.

How to...
Navigate through museum 
Select an Exhibit
Edit or View tank environment 

Interface components
Museum View window
Museum Screen Info buttons
Museum Window Control Buttons 
Museum Control buttons



Museum Screen Info Buttons
These buttons provide information and controls for the selected exhibit. Click on the name of
each button to find out more about its function.

Exhibit Popularity Button 
Exhibit Info Button
Exhibit Control Button
Fish Status Button
Stats Button
Missions Button



Stats Button
This button gives all the information that the game has about you as a player:    Your name, 
your rank (which depends upon the overall popularity of the museum), the number of 
exhibits you have setup, number of trips you have taken, number of fish you have caught, 
number of fish you have accidentally killed (that includes those that have died in your 
exhibits), and duration of the game.



Guide Book Screen
The Guide Book contains information about all fish, plants, objects, tank bottoms, fishing 
equipment, missions, as well as fishing locations around the world.   Click on the Guide Book 
button, which is one of the Museum Control Buttons to access the Guide Book. It is also 
possible to access the Guide Book through the Menu Bar.    In the Menu Bar, click on Window,
and then click on Guide Book

How to...
Find a particular topic in the Guide Book 

Interface components
Guide Book Text Window 
Guide Book Topic Selection Buttons 
Guide Book Scroll Buttons



Playing NC-FF
The main goal of Nature Collector Freshwater Fish is to create a collection of freshwater fish 
and display it in your museum. At the beginning of the game you are an assistant in charge 
of collecting fish for the aquarium(guppy rank). If you are successful, your score and rank as 
a player will grow. You are to collect the fish to setup the displays, and to put them together 
for public enjoyment. This is not as easy as it sounds. GOOD LUCK! 

Main points to keep in mind while playing NC-FF:

Complete all the missions carefully. To learn how to complete a specific mission use the 
Guide      Book.      From the Guide Book you can also obtain information about different fish, 
objects, locations, etc. mentioned in the mission.

Examine your tanks in the museum often. If the fish in a particular tank die, try to modify the
tank controls. Remember, your ultimate goal is to make the entire museum as popular as 
possible, and if the fish do not survive, your exhibition will not attract people to the 
museum.

On the Travel Screen, you can choose where you want to go fishing as well as catch a 
particular fish at that location.

Using the Museum Screen you can view and setup all of the exhibits, as well as tour the 
museum as a whole.



Files menu
This menu provides access to the following file function: EXIT.    To exit Nature Collector 
Freshwater Fish, access the Menu Bar, click on File, and click on EXIT.    As you exit, all 
information about exhibits you have made and fish you have caught will be automatically 
saved so you can continue later if you wish.



Edit menu
The commands of this menu are available only in the Exhibit Setup Screen.

Remove
Flip



Remove

This command can be used to remove items from the exhibit.    To activate this command go 
to the Exhibit Setup Screen, click on the object to be removed, such as a fish, a plant, a rock,
etc., access the Edit Menu in the Menu Bar, and then click on Remove.    This will place the 
removed object into a free slot in the Container Window.    It is also possible to complete the 
same task by selecting an object and then pressing the DELETE key.



Options menu
The following commands are available through the Options menu:
Sound Effects On/Off 
Exhibit Music On/Off 
Background Music On/Off 
Popularity On/Off 
Warnings On/Off 
Simulator On/Off 
Speed... 



Sound Effects On/Off
This command allows the user to turn various sound effects on and off throughout the game.
To toggle between on and off, access the Menu Bar, click on Options and then click on Sound
Effects.



Exhibit Music On/Off
Exhibit Music is the music you hear when you are in the View Exhibit Screen or while Touring 
the Museum you have made.    This command allows you to turn that music on and off. To 
toggle between on and off, access the Menu Bar, click on Options and then click on Exhibit 
Music.



Background Music On/Off
Background Music is the music you hear while you are playing the game, and while Exhibit 
Music is not playing.    To toggle between on and off, access the Menu Bar, click on Options 
and then click on Background Music.



Popularity On/Off
The result of this command can be seen only in the Exhibit View Screen, or in Tour.    If 
Popularity is on, in Exhibit View Screen, you will be able to see the silhouettes of people 
currently watching the exhibit.    As your exhibit grows more and more popular, the number 
of such silhouettes will increase.    If Popularity is off, these silhouettes will not appear.    To 
toggle between Popularity On and Popularity Off, access the Menu Bar, click on Options and 
then click on Popularity.



Warnings On/Off
This command allows you to turn on and off various warning messages that can appear 
during the game.    To toggle between Warnings On and Warnings Off, access the Menu Bar, 
click on Options and then click on Warnings.



Simulator On/Off
With the Simulator On, the physical conditions in the fish exhibit, as well as the health and 
hunger of the fish are continuously recalculated to correspond to your adjustments of exhibit
conditions.    With the Simulator Off, all of these conditions are held balanced. To toggle 
between Simulator On and Simulator Off, access the Menu Bar, click on Options and then 
click on Simulator.



Speed
This menu allows you to adjust the speed of the simulator, from slow to extremely fast-warp. 
The speed at which the game is currently playing is indicated by the checkmark to the left of
one of the listed speeds.    To change the speed of the simulator, access the Menu Bar, click 
on Options, and then click on Speed.    Now click on the desired speed rating.



Window Screen
The following commands are available through the Windows menu:
Full Screen On/Off 
Lobby 
Museum 
Travel 
Guide Book



Full Screen On/Off
This command allows you to toggle between Full Screen View On and Full Screen View Off 
while you are at the Location Screen.    To toggle between the Full Screen View On and Full 
Screen View off, access the Menu Bar, click on Window, and then click on Full Screen.    It is 
also possible to toggle between Full Screen View On/Off, by pressing F8.



Lobby 
By activating this command, you are transported from any location to the Lobby Screen     
To go to the Lobby Screenaccess the Menu Bar, click on Window, and then click on Lobby.    It 
is also possible to achieve the same result by clicking on the Lobby Button which is one of 
the Museum Control Buttons in the lower part of the screen.



Museum
By activating this command, you are transported from any location to the Museum Screen.    
To go to the Museum Screen, access the Menu Bar, click on Window, and then click on 
Museum.    It is also possible to achieve the same result by clicking on the Museum Button, 
which is one of the Museum Control Buttons in the lower part of the screen.



Travel
By activating this command, you are transported from any location to the Travel Screen.    To 
go to the Travel Screen, access the Menu Bar, click on Window, and then click on Travel. It is 
also possible to achieve the same result by clicking on the Travel Button, which is on of the 
Museum Control Buttons in the lower part of the screen.



Guide Book Menu
By activating this command, the Guide Book is shown.    To invoke the Guide Book, access 
the Menu Bar, click on Window, and then click on Guide Book. It is also possible to achieve 
the same result by clicking on the Guide Book Button, which is one of the Museum Control 
Buttons in the lower part of the screen.



Help menu
The following commands are available from the Help Menu:    There are several ways to 
access the Help menu, by clicking on the Help button in the bottom right corner of Nature 
Collection Freshwater Fish window, by accessing the Menu Bar, selecting the Help Menu, and
then clicking on Help, or by pressing F1.
Help 
About



Choose fishing location
Move the cursor over one of the red location squares on the map.    In the Map Window Title 
you will see the name of the location you have selected.    To go to the location, just click on 
one of the red squares.    The location you have selected will start blinking and information in
the Current Location Info Window will be updated.



Map window
The Map window displays a World Map with all the fishing sites shown by red squares on the 
map.    The name of the selected location appears in the Map Window Title. When a location 
mark is clicked, it starts blinking and Current Location Info Window will show information 
corresponding to this location.



Current Location Info window
This window displays a picture, as well as a short description of the location you have 
selected.



Map Window Title
This window displays the name of the location which corresponds to the red location square, 
over which you have placed your cursor.



Current player field
It displays name of the current player.



Login text input box
Type in a new player name in this box. Then click the Login button to set the name of the 
new player.



Login button

This button lets you log into the game. Beforehand you should select a player name in the 
Table of best scores or type in a new player name in the Login text input box. After 
pressing the Login button the selected line is highlighted and the Travel, Museum and 
Guide Book    buttons become available. Now you can play NC-FF!



Catch a fish
You catch a fish by moving it off the top of the screen.    This can be done using all of the 
tools available for catching fish.    See the Guide Book on how to use each tool.    To put a 
fish-catching tool into the water, select it in the Container Window, and click on USE button.   
To activate the tool click your mouse again.    Since there are only twelve fish containers 
available, it is possible to catch only twelve fish at a time.    In order to catch more fish you 
will have to throw some fish back into the water.    To do that click on the fish, and then click 
on the Trash Button.



Container window
The container is the strip of boxes at the top of the Nature Collection Freshwater Fish 
window, in which equipment, fish that you have caught, plants, objects, and bottoms are 
placed.    It enables you to move items from one part of the game to the other. Click on the 
name of the container window elements to see the description of its elements:

Use button 
Trash button 
Container Display area 
Container Scroll bar with thumb button 



Container Display area
The Container Display area shows only six out of total of 65 container boxes available.    Use 
the Container Scroll Bar to scroll through the box items.    To select an item, simply click your 
mouse in the proper Container Window.



Container Scroll bar with thumb button
There are two ways to scroll through the Container Window.    To scroll through the window 
slowly, one by one, click on one of the arrows located below the container window, to the left
or to the right of the scroll bar.    It is also possible to scroll through the Container Windows 
by clicking your mouse within the scroll bar, so the thumb button, which shows the relative 
position of the object being displayed within the container moves to the desired location.



Use button
When you are at the Location Screen, select the desired fishing equipment by clicking on the
corresponding picture in the Container Window and then click on the Use button. This will 
enable you to use the selected equipment for fishing.
When you are in the Exhibit Setup Screen, select the desired item in the Container Window, 
and then click on the Use button - the item you have selected will be added to the tank you 
are setting up.



Trash button
When an object is selected, press this button to remove the object from the Container 
window. A message box asking whether you are sure about your actions will appear.    Click 
on Yes to remove this object, and click on No to leave the item in the container.



Video playback area
In this area you can see video movie.



Video Control Buttons
This is the window which enables you to control all the video-playing that is done throughout
the game. Click on the description of the button in the control panel to find out how it works.
Fast rewind button
Rewind button 
Stop button 
Play button 
Fast Forward button 



Fishing Location Screen
Lets Go Fishing!    The Fishing Location Screen displays the chosen location (river, lake), 
where freshwater fish live.    In this window you try to catch fish to bring back to the 
museum.    You can get here by pressing the Go  Fish button in the Travel Screen. You can 
return from the Fishing Location Screen to the Travel Screen by pressing the ESC key or by 
clicking on the Travel    Button. 



Log in the game
Select a line with your name in the Table of Best Scores or Enter a New Name.    Once you 
have done that the line that you have selected will be highlighted.    Click on the Login 
Button to record your name.    Your name now will be displayed in the Login Name Display     
Box.    All Museum Control Buttons become available - you can start.



Table of Best Scores
The Table of Best Scores contains information about the best players: Name of a player, his 
or her final score, his or her rank as a player and the number of    exhibits he or she has 
organized.    Information is sorted by the players final score.



Exhibit Popularity Button
This button lets you observe the popularity of the whole museum (top graph) and the 
popularity of the currently selected exhibit (bottom graph).    The bottom graph will not work 
when no exhibits are selected.    The top graph is calculated from the popularity of all the 
exhibits you have set up.    Popularity of the exhibit depends on how successful you were in 
setting up the exhibit and keeping the fish healthy.    Your score depends on the popularity of 
the whole museum. 



Help
To start Help, access the Menu Bar, select the Help menu, and then click on Help.



About
To activate this command, access the Menu Bar, click on the Help Menu, and click on About.  
This will bring up a window with the latest version information about NCFF, as well as the 
people who worked on this game.



Lobby Button
Click on this button to display the Lobby Screen .



Travel Button
Click on this button to display the Travel Screen.



Museum Button
Click on this button to display the Museum Screen.



Guide Book button
Click on this button to display the Guide Book.



Museum View window
In this window you can see the 3D or the 2D view of the museum.    You can Navigate 
through the museum (in 2D and 3D) , or Edit or View tank environments. This window is 
displayed when you enter the Museum screen.    This window can be controlled with the help
of the Museum window control buttons. 



Museum View Control buttons
These buttons allow you to go along the exhibition. Two buttons let you go forward and 
backward, other two let you rotate left and right.    To select any exhibit, situate yourself with
Control buttons near the particular exhibit and left-click on it.



Navigate through museum
There are two ways to navigate through the museum in the 3D view.    You can either use 
your mouse or your keyboard.    

By pressing the left arrow and right arrow keys you will turn either left or right.    By pressing 
the up arrow key you will move forward, and by pressing the down arrow key you will move 
backward.    

You can also move around the museum in 3D view by using your mouse.    First move the 
mouse cursor in the center of the 3D Museum View.    Now depress the mouse button and do 
not release it.    You will find yourself slowly moving forward.    If you want to go backward, 
just move the mouse cursor toward the lower portion of the 3D Museum View.    To move 
right or left, move your mouse to the right or left side of the 3D Museum View.    Remember, 
the farther you are from the center of the screen the faster you will move through the 
museum halls.    You can stop either by releasing your mouse button, moving your mouse 
cursor to the lower center of the screen, or by moving the mouse cursor outside the 3D 
Museum View part of the screen.

Unlike the 3D Museum View, movement in the 2D Museum View is not dynamic.    To access 
the 2D Museum View, in the Museum Screen, click on Switch View button.    After you have 
switched from 3D to 2D Museum View, a picture on which six pentagons, each corresponding
to an exhibit hall, will appear.    This is a top view of the whole museum.    You can click on 
any one of 30 exhibits to go to it.



Edit or View exhibit environment
First you should Select an Exhibit.    After a tank has been selected,    you can either choose 
Exhibit Setup (to edit or create tank environment) or View Exhibit.    



Museum window control buttons
These buttons enable you to manage the Museum View window.    They are active only when 
you are in the Museum screen. Click on the name of the button to find out more about its 
function.
Exhibit Setup Button
View Exhibit Button
Tour Button
Switch View Button 



Exhibit Info button
This button shows you the names of the fish and plants that are currently in the exhibit you 
have selected.    Those fish which have died have a plus sign in front of their name.



Exhibit Controls button
This button allows you to control the temperature, oxygen level, filtering, and food in the 
selected exhibit.    Each of the control parameters has a slider, which can be used to increase
or decrease the level of that parameter by sliding the arrow to the right to increase and to 
the left to decrease.    Also, each of the control parameters has an on/off switch.    Unless the 
switch is on, moving the sliders will have an effect.    To turn the switch on, click on it with a 
mouse button.    When on, it will light up with a light that corresponds to the color of the 
slider.    The window above the sliders indicates graphically the changes in the levels of the 
control parameters that you implemented.    Energy bar beneath the sliders indicated the 
maximum level of energy you are allowed to use in each exhibit.    If it is already at its 
maximum, you will not be able to increase any of the control parameters.



Fish Status button
This button gives information about all the fish in an aquarium you have selected.    You 
observe the status of one fish at a time.    You can advance from one fish to the other by 
using scroll buttons, situated at the bottom of the fish status display.    
You learn, its age, its sex, its health and hunger graphs.    To see its health or hunger graphs, 
press the corresponding button.    They are situated right under the picture of the fish that 
you are currently observing.    Once the button is pressed, it becomes highlighted and the 
desired graph appears.    If you want to change the period of time, for which the graph is 
drawn, press one of the buttons situated right above the scroll buttons.    You can choose 
between hours, days, and weeks.    Once one the buttons is pressed, it appears to be 
depressed and highlighted with red.



Missions button
The missions button will activate the video which corresponds to the selected tank.    It will 
also display the name of the mission and mission status, which demonstrates how successful
percentage-wise you were in completing the mission so far.    Once you have completed 70 
percent of a mission, expect a surprise!



Exhibit Setup screen
It is possible to setup and edit the exhibit that you have selected. It has two modes: Full 
Screen On and Full Screen Off.    You can go to the Exhibit Setup screen by pressing the 
Exhibit Setup Button from the Museum screen. To return to the Museum screen, press the 
Return button which is located on the Exhibit Control button bar.

How to ...
Add an object to the exhibit 
Remove an object from exhibit and return to the container 
Flip objects 
Move objects 
Select object 
Import a background picture 
Attach Music to an Exhibit 
Return to the Museum screen    

Interface components
Container window
Exhibit window



View Exhibit screen
The View Exhibit Screen allows you to view an exhibit in the same way as a museum 
visitor would see it.    To go to the View Exhibit screen, click on the exhibit from either the 
2D or 3D Museum Screen, and then click on the View Exhibit button in the lower left 
corner of the screen.    

How to ...
Return from viewing to the Museum screen
Switch Popularity On/Off
Exhibit Music On/Off 



Video Progress Bar
While the video clip is playing, the Progress bar changes its color from red to yellow to 
indicate how much of the video has already played.



Exhibit Setup button
This button moves you to the Exhibit Setup Screen.



Select an Exhibit
To select an exhibit, either move to it in a 3D mode and then click on the picture that 
represents it or, in a 2D mode, click on the panel in the map that corresponds to the desired 
tank.    The tank becomes highlighted with a yellow frame (3D) or turns from a blue to a 
yellow rectangle (2D). Information in the Museum screen info window will now refer to the 
selected tank.



View Exhibit button
This transports you from the Museum Screen to the View Exhibit Screen.



Tour button
This button allows you to tour all the exhibits that you have setup.    You will see your 
exhibits as any museum visitor would.    Once you have started your tour, press SPACEBAR 
to go from tank to tank.    Press ESC to stop your tour.



Switch View button
Clicking on this button allows you to switch from a 2D view of the museum to a 3D view, and
back.    



Exhibit window
This window displays a preview of how the exhibit is going to appear to the museum visitors.
The only difference is that here, all animated objects are shown as icons, and do not actually
move.



Add Music to Exhibit
Click on the Music button in the bottom of the Exhibit Setup Screen.    A new dialog box will 
appear, which showing all the music (*.mid) files available.    You may select any of the files 
as a background music for your exhibit.    To select music for an exhibit, select the one you 
like by clicking on it and then click on the OK button, located at the bottom of the dialog 
box.



Guide Book Text Window
This window contains information about the topic currently selected.    Use the Guide Book 
Topic Selection Buttons to change the topic of information currently displayed in the Text 
Window.    Use the Guide Book Scroll Buttons to scroll to the next page of information on the 
current entry, or to go to the next entry in the same topic.    Click on any red-highlighted 
words, to change the entry in the Text Window to one describing the highlighted word.



Guide Book Topic Selection Buttons
With these buttons you can load different topics of information into    the Guide Book Text 
Window.    Topics of information include:
Fish
Plants
Objects
Bottoms
Equipment
Locations
Missions



Guide Book Scroll Buttons
It allows you to navigate through the information in the Guide Book. Click on any of the 
following descriptions of buttons to learn more about their actions.
Scroll Up Button
Scroll Down Button
Scroll to Next Entry Button 
Scroll to Previous Entry Button
Collect 



Enter a new name
Select a line that has no name in the Table of best scores by clicking on it. The line you have 
selected will become highlighted.    Type your new name in the Login text input box.    Click 
on the Login button to set your new name.    Your name will now be displayed in the Login 
Name display box.



Change a name
Select a line with the name you want to change in the Table of Best Scores. The name will 
appear in the Login text input box . Type your new name.    Click on Login Button to set your 
new name.    Click on CANCEL when asked whether you want to erase all game parameters.



Delete a name
You can delete a name by starting a new game under a different name.    To do that, select a 
line with the name you want to delete in the Table of Best Scores. Type in your new name, 
press ENTER, and click on DELETE to delete a name, and start a new game.



Add object to the exhibit
To add an object to the exhibit, click on the objects icon in the Container window    to 
highlight it and press the USE button, or you can just double click on the object you want to 
put into the exhibit.    If the object selected is always stationary, it appears highlighted, full-
size in the front center of the exhibit. If the object is an icon object such as fish or 
animations, it appears as a small icon in the upper left part of the exhibit screen.    If there 
are multiple icons,    the next icon is placed to the right of the previous icon on the same line.



Go Fishing 
To go fishing to the location you have selected in the Travel Screen, just click on the Go 
Fishing ... button



Remove object from exhibit and return to the container
There are three ways to remove an item from the exhibit:    

Keyboard: click on the desired item and then press the DELETE key.

Remove Button:    click on the desired item and choose the Remove button, which is located
at the bottom of the Exhibit Setup Screen.

Menu Bar: click on the desired item and then select REMOVE from the Edit menu.



Flip objects
This command can be used to flip an object in the Exhibit Setup Screen creating a mirror 
image of the original object.    To flip an object, select it by clicking it, then access the Edit 
Menu in the Menu Bar, and then click on Flip.    It is also possible to complete the same task 
by selecting an object and clicking on the Flip button in the lower left corner of the Exhibit 
Setup Screen.



Move objects
To move an object on the screen, click on the item and drag it to the desired position.    You 
can move an item in all three dimension in the exhibit you are setting up.    To move an 
object into and out of the screen, hold down the SHIFT key, then click on the item and drag 
it to the desired position.



Select object
To select an object while in Exhibit Setup Screen, simply click it with your mouse.



Import a background picture
To choose a background for your exhibit, click on the Background Button at the bottom of 
the screen.    If you would like to put in a picture as a background for your tank, click on 
Pictures.    You can also choose to make the background a shade of one color, by clicking on 
palette.    Click on the scroll bar arrows to scroll through all the possible background.    When   
you have found the background you like, simply click on it, and then click on OK.    If you do 
not want to make any changes, click on CANCEL.



Find a particular topic in the Guide Book
First choose what kind of information you want to see by clicking on one of the Guide Book 
Topic Selection Buttons.    Then click on one of the Guide Book Scroll Buttons to find 
information about a particular entry.



Remove an item from container
If your container is full, and you want to catch more fish, select an item in the Container 
window, click on the Trash button, or press the DELETE key.    The object will be removed 
from the container.



Return to the Museum screen
To return to the Museum Screen from the Exhibit Setup Screen, either press the ESC key or 
click on the RETURN button in the bottom of the screen.



Return from viewing to the Museum screen
To return from the View Exhibit Screen to the Museum Screen, press the ESC key on the 
keyboard.



Scroll Up Button
This button allows you to scroll up through one of the entries in the Guide Book.



Scroll Down Button
Click on this button to scroll down in the Guide Book entry you have selected.



Scroll to Previous Entry Button
Click on this button to retreat to the previous entry in the same category of the Guide Book.



Fish Entries Button
Click on this button to see a list of all the fish in the game.



Plants Entries Button
Click on this button to see a list of all the plants available in the game as well as their 
descriptions.



Objects Entries Button
Click on this button to see a list of all of the collectible objects in the game.



Equipment Entries Button
Click on this button to see descriptions of all equipment available in the game.



Locations Entries Button
Click on this button to see descriptions of all locations in the game.



Missions Entries Button
Click here to see a list of all the missions you will complete to finish the game.



Collect Entry Button
Click on this button to collect the item currently displayed in the Guide Book Text Window.    
This button is only available for collecting plants, objects and exhibit bottoms.    For other 
objects, such as fish, this button cannot be used.    You must GO FISH in order to collect fish.



Scroll to Next Entry Button
Click on this button to advance to the next entry in the same category of the Guide Book.



Help Button
Click on this button to display the Help Screen.



Museum Button
Click on this button to display the Museum Screen.



Login Name Display Box
The Login Name Display Box is located at the top of the Table of Best Scores.    It shows the 
name of the player currently in charge of the Museum.



Fast Rewind Button
This button brings you back to the beginning of the video clip.



Rewind Button
This button allows you to return to a place in the video clip which you might have missed.



Stop Button
This button stops the video.    The video clip will remain at the place at which you have 
stopped in case you would like to continue.



Play Button
Click on this button to start the video clip.



Fast Forward Button
This button allows you to fast forward the video clip to the moment you would like to see.



Bottoms Entries Button
Click on this button to see a list of all tank bottoms available in this game.
 




